iCyte/iCys Revision 3.0 User Tutorial

Exercise 1

Exercise 1: One Primary Contour Scans

The purpose of this document is to provide the experienced iCyte user with an overview
of the basic operation within iCyte software version 3.0

Before starting this tutorial ensure that iCyte revision 3.0 has been successfully installed.

Users should review the iCyte version 3.0 Release Notes before proceeding with this
tutorial.

Start-up/Creating Workspaces

Turn on the iCyte main power and laser power.
Turn on the computer and all accessories.

Launch the iCyte application by double clicking on the iCyte desktop icon. The
main iCyte screen will open.

You will note that there have been some changes made to the main screen
particularly in the side Task Bar.
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4. From the side Task Bar select New Run. The New Run window will open:
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It is from this window that you will begin the process of setting up a workspace
for scanning.

CompuCyte has provided a number of Templates that cover the most common
scanning modes. These templates can be used as a starting point to build
customized Workfiles.

Note: The above window is for iCyte/iCys instruments without the iNovator
Application Development Tool Kit. Systems with iNovator will have
additional templates.

5. Select [1] One Primary from the Template list and click on OK. The template
will open and display 2 tabs (titled Protocol and Data). The Protocol tab will
display 3 windows: Protocol, Field Image and 96 Well Plastic Plate (carrier).
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For this exercise the carrier type will need to be change to Standard Slide. To do

this, click on the Select Carrier type icon in the carrier window and select

Standard Slide from the list.

Select Carrier Type x|

Carrier Type
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Detector Module

7. In the Protocol window, Click on the Detectors Module, the details of the
Detector module will be displayed on the right portion of the window.
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8. Select Edit, the Detector selection window will open, here is where you select the
laser(s) and detectors for the scan. In the One Primary template, the 488 laser
and Green, Orange, Long Red and Scatter channels are selected. For this
exercise, deselect the Green, Orange and Scatter channels.
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Note: Any combination of lasers can be selected for either pass, for example,
the 633nm laser can be used in the first pass and the 405 nm or 488 nm
laser used in the second pass.

9. Select OK to close the detector selection window.

10. Click on the Color box in the Detector window to view the CompuColor selection
for the Long Red Channel.

Set Channel Color ; x|
— CompuCaolor
Cancel |
Apply |
Fed - @l

The iCyte application has the following CompuColor defaults set.

Channel Default CompuColor
Green Green
Long Red Red
Scatter Gray
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Field Scan Module

11. Click on the Field Scan Module to display the scan parameter.

12. Select the General Tab and select the 20x objective, and X step size of 0.5 p,
and a Field Size of 100%.

13. Select the Advanced Tab and ensure Correct Pixel and Save Field Image boxes
are selected.
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—Mozaic image

[ Save [ Test

[ Stop on count

Region: |1 Pirel size: |5 i
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Channel Module

14. Click on the Channel Module to select the contouring channel.

15. Click on the Channel drop down menu to select Long Red as the contouring
channel.

Phantom Module

16. The Phantom Module is deselected (darker gray) and not active in this template.
Threshold Module
17. Click on the Threshold Module, select manual and enter a value of 1000. Note

that the value in the Threshold Module box changes to indicate the threshold
value.
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Contour Module

18. Click on the Contour Module, Enter Primary as the Component Name, a
minimum area of 20 p? In the Draw box the color of the Primary contour is set to
red (iCyte default).

Contour

Component name:

Frirarny

Min area: |2D & pm?

' mm?

[~ Check max area

[~ Follow concave contaur

Diraw

Color: I Red 'I_@

I~ Fil

Note that in the lower right portion of the Contour Module a small red circle
appears indicating the color of the event contour.

Contour
LongRed g

19. Click on the Event Module, and then click on the Contour Tab. To set the
Integration contour, enter a value in the expand by field, the iCyte default value is
4. The color of the integral contour is set to green (iCyte default).

20. Select the Background Tab, check Use Dynamic Background and enter a
distance value of 6 and a width value of 3 in the appropriate fields. The color of
the background contour is blue (iCyte default).

21. Select the Long Red channel in the Corrected channels box.

Event Module
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22. Initialize the protocol by clicking on the .ﬂ in the Protocol Window icon bar.
Run Statistics

23. Click on the Statistics box in the side Task Bar to set-up the Run Statistics
(formerly Well Features).

24. Select the Well Tab and New to create Run Statistics.
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aK i Cancel |
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25. In the Run Features for Well window that opens, select Primary as the
Component.
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. In the statistics column select Count, Mean and CV. Multiple statistics can be

selected at the same time by pressing the Ctrl key and highlighting the desired
statistics.

. In the Features column, select Integral.
. In the Channel column select Long Red.
x
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Data Display

29

30.
31.
32.

33.
34.

35.
36.
37.
38.
39.

. Select the Data tab at the top of the window; this Template does not have any
analysis widows created so the tab will be blank.

Select View from the top menu bar then New Scattergram.
Double click in the field of the scattergram to open its properties.

Configure the scattergram to show the Long Red Max Pixel on the X-axis and the
Area on the Y-area.

Create 2 rectangular regions (R1 and R2) in the scattergram just created.

Create a second scattergram showing the Long Red Integral on the X-axis and
the Area on the Y-axis.

Create a Histogram for the Long Red Integral.

Create a region (R3) in the Long Red Integral histogram.

Create a new Tab by selecting Setup then New Tab from the top menu bar.
Enter Galleries as the new tabs name and click on OK

Highlight the Galleries Tab and Select View then New Gallery from the top menu
bar. Create a Gallery for Regions 1 and 2.

Page 9



iCyte/iCys Revision 3.0 User Tutorial

Exercise 1

40. Select File and Save Workspace as: The save window will open providing you
with an opportunity to name this workspace and notations about the workspace.

Save Workspace As E x|
Existing workfiles T T uborial Exercize 1

Tutorial Exercize 1

Annaotation:

Field Scan with one lager and one
chaninel

Cancel |

Test Scanning

Note: Although this tutorial uses a raw data file, steps 1 — 4 describe how the PMT
were set.

1. Select Field Image from the side Task Bar, this will open the Field Image window
This window is essentially the same as the Scan View window in software
version 2.6, with one notable exception; the scan control keys have been
removed from the Field Scan window and placed in the side Task Bar.
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2. The process of setting the PMT’s to achieve optimal fluorescence intensity in the
Field Scan window remains the same. A test scan is initiated using the Test
Scan or Single Scan control in the Scan side Task bar.

3. The Detector module in the Protocol window is opened and adjustments are
made to the PMT Voltage (%) and Offset (volts).

Detectors

Lazer Power [488 nm)] |5 i

Calar... W Set Default

Charnel | Wirtual Channel I Scatter I

Waltage Gain  Offset
[%] (%] [Wolts]

LongFed  fo5  Jioo o

Edit... |
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4. Contours are set through adjusting the Threshold value in the Threshold module
in the Protocol window.

Threshold

' futg
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I
/

5. The test scan can be stopped by clicking on the stop icon in the Scan area of the
side Task Menu bar.

Opening Runs

For this part of the tutorial, insert the iCyte/iCys Revision 3.0 Tutorial data disk into the
CD-ROM drive of the computer.

1. Select Open Run from the side Task Bar, the Open Run window will be

displayed
i
—Fun
Diata Cyte Custam Recent
MNumber: 240 Instrument: |5IJ2‘I
240 - Tutarial Exercize 1
I ame: ITutoriaI Ewercize 1

Anmotation: |20 <lide 15

Created: |1 24242004 8:32 AM

Data; IFieId+Mosaic

Fath: |E:\Program FileghCompuCyteticyteh D ataCytet 5021 -240-Tutorial E xercize Browse. . |
Wworkspace | [ Analyzis Mode

|240 - Tutorial Exercise 1 % Analyze events

| Keep curent workspace " Reanalyze

% Runworkspace

€ Oher Select... |

el _|
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The Open Run window makes it easy to import a Run.xml file from a number of a
different locations. Data files located in the DataCyte folder as well as a
customized location can be displayed by clicking on the appropriate box.

Highlighting the data file will display the information about the data file in the Run
field.

Users can also select a Workspace other than the run files Workspace to view
the data with by selecting the desired Workspace in the Workspace field.

2. For this exercise click on the Browse button and navigate to the computers CD-
ROM drive, select Tutorial Exercise 1 and Open.

3. Select Run.xml and Open.

4. Select Reanalyze in the Analysis Mode box. This is analogous to selecting the

Active Data — Raw data in software version 2.6. Selecting Analyze Events is
similar to setting the active data to Event data in version 2.6.

i

Select OK, the Workspace from the run will open with the run information.

o

Select File > Open Workspace from the top menu bar. Select No to save protocol
question.

N

Highlight the workfile that was created and OK.

®

Select Single Field from the side Task bar to start the reanalysis of the data file,
the Field Image window will display the first scan field.

©

Display the event contours and check that all events in the scan field are
contoured, if not, click on the Threshold Module and adjust so that all beads in
the scan field are contoured.

10. Click on the Data tab and reposition R1 on the single bead population and R2 on
the double bead population in the Long Red Max Pixel vs. Area scattergram.

11. Reposition R3 in the Long Red Integral histogram on the single bead peak.
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12. Stop the Test scan.
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Scan and Save

1. To start a scan Select Scan and Save from the side Task Bar. The Scan and
Save window will open.

Scan And Save 1 |

Fun number  Run name

n |

Annotation
20 slide 15

—Data Saving

¥ Save field images IJpeg ¥ l

[ Save Field Scan mosaic images

Statistics: INone

Enter a Run name in the Run name field.
Enter any notations about the specimen or scan in the Annotation field.

Select how you want the raw data to be saved, either Jpeg or Flat, these remain
the same as in revision 2.6 software.

5. Select Save Field Scan Mosaic Image if you would like to save a mosaic image
of all scan fields together (Well Image)

Click OK to initiate the scan and save.

When the scan is completed the Scan Complete window will appear. Click on
OK to clear the window.

8. Select View — Run Statistics to display the well statistics specified earlier in the

LS A
wel |
4 |wel | Long Fled Area Mean R1 | Long Fed Area Mean R2 | Long Red Integral Long Red Mean BT | Lang Red Integral Long Fed Mean A2 | Long Red Count | Long Red Count R1 | Long Aed Count A2 |
1 1 116 227 2993016 B.051.612 292 746 el

9. Select View — Region Statistics will display the statistics for each region as in
software version 2.6.
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Region Statistics
Region | Label | Paramn | Mean [ O % [STD [ P HbA 2 i
51(945:99%) Long Red Max  13233.47 E.82 903.04 317
Area 162.82 40,17 £1.39 534
A1 [794:83 Long Red Max 1321784 319 421.98 297
Area 133.42 419 5.59 292
R2 [84:8%) Long Red Max  13604.42 282 35606 2.26
Area 25552 5.02 12.83 317
52 [(918:97%) Long RedInte 3882927.02 3075 119386265  4.08
%' Position 1357877 9.75 1323.42 13.27
H3 [918:97%) Long RedInte 3882927.02 3075 119386265  4.08
R3(791:83 Long RedInte 352091976 3.07 108247 66 2.96

10. Adjustments can be made to regions and the data in both the Run Statistics and
Region Statistics windows will be updated.

11. Click on the Galleries tab to view the galleries from Region 1 and Region 2. Note

that both the Long Red detector and CompuColor images are saved.

Gallery [R1]

Long Red CompuColar i
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